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About This Guide
Welcome to the Taxonomy Editor Guide. This guide describes how to use Taxonomy Editor as part of HP
SOA Systinet.

This guide contains the following chapters:

• Chapter 1, Taxonomy Editor

Provides an overview of the main features of Taxonomy Editor.

• Chapter 2, Getting Started

Describes the installation of the main features and shows you how to create a taxonomy project.

• Chapter 3, Manipulating Taxonomies

Explains how to create, download, edit, and compare assertions.

• Chapter 4, Publishing Taxonomies

Explains how to publish taxonomies to a server.

• Chapter 5, Deploying Taxonomies

Shows how to build a Taxonomy Extension project using Taxonomy Editor.

• Chapter 6, Conflicts and Validation Issues

Shows how to resolve conflicts with taxonomies.
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Document Conventions
This document uses the following typographical conventions:

Script name or other executable command plus mandatory arguments.run.bat make

Command-line option.[--help]

Choice of arguments.either | or

Command-line argument that should be replaced with an actual value.replace_value

Choice between two command-line arguments where one or the other is
mandatory.

{arg1 | arg2}

User input.rmdir /S /Q System32

Filenames, directory names, paths and package names.C:\System.ini

Program source code.a.append(b);

Inline Java class name.server.Version

Inline Java method name.getVersion()

Combination of keystrokes.Shift+N

Label, word, or phrase in a GUI window, often clickable.Service View

Button in a user interface.OK

Menu option.New→Service
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Documentation Updates
This guide's title page contains the following identifying information:

• Software version number, which indicates the software version.

• Document release date, which changes each time the document is updated.

• Software release date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service.
Contact your HP sales representative for details.
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Support
You can visit the HP Software Support Web site at:

http://www.hp.com/go/hpsoftwaresupport

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way
to access interactive technical support tools needed to manage your business. As a valued support customer,
you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a
support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
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1 Taxonomy Editor

HP SOA Systinet Taxonomy Editor is a set of Workbench features that enable you to manage taxonomies
in SOA Systinet.

You can use HP SOA Systinet Taxonomy Editor to create, modify, and delete taxonomies. You can also
download taxonomies from, or upload them to, any number of SOA Systinet servers.

This chapter introduces Taxonomy Editor in the following sections:

• Workbench Suite on page 9

• Overview on page 10

• User Interface on page 11

Workbench Suite
HP SOA Systinet Workbench is a suite of editor tools enabling you to customize your deployment of SOA
Systinet.

Workbench consists of the following editor tools, distributed as a single Eclipse development platform:

• Customization Editor

Customizes the underlying SOA Definition Model (SDM) and the appearance of these artifacts within
SOA Systinet.

• Taxonomy Editor

Customizes the taxonomies used to categorize artifacts in SOA Systinet.

• Assertion Editor

Customizes the conditions applied by your business policies within SOA Systinet.
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• Report Editor

Customizes report definitions for use with SOA Systinet.

Overview
Taxonomies are, in their simplest form, a visual representation of what your organization actually knows.
A well-constructed, meaningful taxonomy enables users in your organization to quickly find the information
they need to achieve their goals.

Taxonomy Editor enables you to organize and reorganize content easily, giving more flexibility for knowledge
sharing in your organization

Use Taxonomy Editor to do the following:

1 Create a Taxonomy Project.

For details, see the following sections:

• Creating a Taxonomy Project on page 27

• Downloading Taxonomies from a Server on page 28

• Searching for Taxonomies on page 29

2 Create and manage taxonomies.

For details, see the following sections:

• Creating Taxonomies on page 33

• Modifying Taxonomies on page 34

• Cutting, Copying, and Pasting Taxonomies on page 35

• Deleting and Restoring Taxonomies on page 35

• Updating, Importing, and Exporting Taxonomies on page 36
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3 Publish taxonomies to an SOA Systinet server.

For details, see the following sections:

• Publishing Changes on page 43

• Example: Creating and Publishing a Department Taxonomy on page 44

4 Check local validity and manage conflicts.

For details, see Resolving Conflicts and Validation Issues on page 53.

User Interface
The default perspective is split into a number of sections, with menu options across the top, as shown in
Figure 1.
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Figure 1. Taxonomy Editor UI

The platform perspective consists of the following views:

• Project Explorer

The tree view of your taxonomy projects. For details, see Project Explorer on page 13.

• Server Explorer

The view listing SOA Systinet server connections to the Workbench. For details, see Server Explorer
on page 15.
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• Editor

The view showing the components of the taxonomy. For details, see Editor Pane on page 16.

Project Explorer

Project Explorer contains a hierarchical list of projects, the taxonomies in each project, and the categories
and subcategories of each taxonomy, as shown in Figure 2.

Figure 2. Taxonomy Editor UI: Project Explorer

Right-click elements in the project to view their context menus, as described in Table 1.
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Table 1. Project Explorer Context Menu Options

DescriptionOption

Opens a new project, file, or folder. You can also create a new taxonomy.New

Opens the taxonomy in the default Editor.Open

Opens the taxonomy in editors other than the default Editor.Open With

Copies the selected item to the clipboard.Copy

Pastes a copied item from the clipboard into Project Explorer.Paste

Deletes the selected item.Delete

Moves the selected item to a different location.Move

Renames the selected item.Rename

Imports a taxonomy from a local file into the project.Import

Exports a project or taxonomy to a file or Team Project Set.Export

Reflects changes made outside the workspace. The local version does not change.
This is the standard Eclipse Refresh action.

Refresh

Opens the project to users.Open Project

Closes the project to users.Close Project

Runs a compliance check on the selected item.Validate

Opens the Run dialog box.Run As

Opens the Debug dialog box.Debug As

Opens the Profile dialog box.Profile Aa

Applies a Patch from a team project, or shares your project with a team.Team

Compares the current version of the taxonomy with the history of its local
changes.

Compare with

Restores deleted resources from local history.Restore from Local
History

Formats the documents source code.Source→Format
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DescriptionOption

Does one of the following:

• Downloads a taxonomy from the server.

• Publishes the taxonomy to an SOA Systinet server.

• Updates the taxonomy with the version on the server.

• Removes the taxonomy from the server.

• Publishes the taxonomy to a different server.

• Validates data consistency.

• Compares the selected taxonomy with the latest version on the server.

• Shows artifacts using the taxonomy.

HP SOA Systinet

Converts projects to plug-in projects.PDE Tools

General properties of the project, taxonomy, or implementation. Here you can
set read-only status.

Properties

Server Explorer

The Server Explorer displays the SOA Systinet servers connected to Workbench, as shown in Figure 3. The
functionality is shared by all the Workbench editors.
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Figure 3. Server Explorer View

Right-click a server in the Server Explorer to open the context menu described in Table 2.

Table 2. Server Explorer Context Menu Options

FunctionOption

Add a server for downloading assertions and taxonomies (Assertion Editor,
Taxonomy Editor, and Customization Editor).

New Server

Delete a server from the Server Explorer.Remove Server

Download a taxonomy from a platform server (Taxonomy Editor and
Customization Editor).

Download Taxonomy

Download assertions from a platform server (Assertion Editor).Download Assertion

Download reports from a reporting server (Report Editor).Download Report

View and edit the server name, URL, username, and password.Properties

Editor Pane

The Editor pane is the main feature of the Taxonomy Editor UI.

It has four tabs, described in the following sections:

• Overview Tab on page 17
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• Categories Tab on page 18

• Advanced Tab on page 20

• Source Tab on page 23

Overview Tab

The Overview tab shows the components of the taxonomy, as shown in Figure 4.

Figure 4. Taxonomy Editor UI: Overview Tab

The first section is General Information, where you can view and edit the following properties:

• Name

Name for the taxonomy. The content of the name element in the taxonomy's XML representation.

• Taxonomy ID

Identifier for the taxonomy, with the preceding uddi:. The value of tModelKey attribute in the taxonomy's
XML representation.

• Description

Description of the taxonomy (optional).

The second section is Origin, which shows:
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• Resource URL

REST interface URL enabling the published taxonomy to be viewed on the server.

Categories Tab

The Categories tab enables you to change the structure and properties of taxonomy categories, as shown in
Figure 5.

Figure 5. Taxonomy Editor UI: Categories Tab

You can use the Categories tab to do the following:

• Add a New Category on page 18

• Remove a Category on page 19

• Copy, Cut, and Paste Categories on page 19

• Move Categories on page 20

Add a New Category

To add a new category to a taxonomy:

1 Open the required taxonomy in the Editor pane and click the Categories tab.

2 Do one of the following:
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Click Add Next to add a new category at the same level.•

• Click Add Child to add a new sub-category.

The New Category wizard opens.

3 Enter the category properties, as follows:

• Name

Name for the category. This represents the value of the keyName attribute in the taxonomy's XML
representation.

• Value

Identifier for the category. This represents the value of the keyValue attribute in the taxonomy's
XML representation.

• Disabled

Select this check box to make sure the category cannot be used in an artifact.

4 Click Finish.

The new category is displayed in Category Structure.

Remove a Category

To remove a category:

• Right-click the category in the Category Structure pane to open its context menu, and select Delete.

The deleted category is no longer visible in the Category Structure pane.

Copy, Cut, and Paste Categories

To copy, cut, or paste a category:
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1 Right-click the required source category in the Category Structure pane to open its context menu, and
then select Copy or Cut.

2 Right-click the required destination category in the Category Structure pane to open its context menu.

3 Do one of the following:

• Select Paste to add the category as a sub-category.

• Select Paste as Sibling to add the category at the same level.

Move Categories

To move a category:

1 Select the required category in the Category Structure pane.

2 Do one of the following:

• Click Up, to move a category up.

• Click Down, to move a category down.

• Click Unindent, to move a category to the left.

• Click Indent, to move a category to the right.

To move multiple categories at the same time, you must select categories that are consecutive.

Advanced Tab

The Advanced tab enables you to set properties used with UDDI, as shown in Figure 6.
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Figure 6. Taxonomy Editor UI: Advanced Tab

It is divided into the following sections:

• Compatibility on page 21

• Categorization on page 21

• Validation on page 22

• Reference on page 22

• Value Type on page 22

Compatibility

Enables you to select one or more of the main UDDI structures for the taxonomy. For example,
businessEntity, businessService, bindingTemplate, and tModel.

All structure types are selected by default.

Categorization

Enables you to select from the following taxonomy types:

• categorization
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Tags the UDDI structure with additional information, such as identity, location, and description.

• categorizationGroup

Groups several categorizations into one logical category. For example, a categorizationGroup could be
a geographical location comprised of two categorizations: longitude and latitude.

The categorizationGroup option is disabled if the taxonomy has any categories.

• Identifiers

Reference published information in businessEntities and tModels.

• Relationships

Defines the relationship between two businessEntities in Publisher Assertions.

Validation

Sets whether or not the values in keyedReferences within the taxonomy are checked. The validation service
can check the expected syntax of values. For example, a credit card number or an ISBN number.

Validation can be against Taxonomy Editor's internal validation service or against an external service.

To select an external validation service, do one of the following:

• Enter the endpoint URL.

• Leave keyedReferences unvalidated.

Reference

Enables you to add a reference to a key type.

Value Type

Enables you to Select a Value type for keyValues, using one of the following comparators:

• systinet-com.comparator.string
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keyValues are treated as string values. The maximum length is 255 characters.

• systinet-com.comparator.numeric

keyValues are treated as decimal numbers. The value can have a maximum of 19 digits before the
decimal point and a maximum of 6 digits after the decimal point.

• systinet-com.comparator.date

keyValues are treated as dates.

• custom

Endpoint URL of a custom comparator.

Source Tab

The Source tab enables you to view and directly edit the XML representation of the taxonomy, as shown
in Figure 7.

Figure 7. Taxonomy Editor UI: Source Tab

Customization

Some settings are customizable in Workbench for Taxonomy Editor.
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To change Taxonomy Editor preferences:

1 Select Window→Preferences.

The Preferences dialog box opens.

2 In the tree menu, select HP SOA Systinet→Taxonomy Editor.

3 You can change the following:

• Default taxonomy namespace

The default namespace setting is 5.5. However, version 5.5 taxonomies cannot be used in HP SOA
Registry Foundation 5.0. Make sure you select the appropriate setting.

• Data consistency

Select Validate before publishing taxonomies to validate changes before publishing them to the
server.
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2 Getting Started

This chapter describes the prerequisites for working with taxonomies in HP SOA Systinet Taxonomy Editor.
It contains the following sections:

• Installing Workbench on page 25

• Creating a Taxonomy Project on page 27

• Downloading Taxonomies from a Server on page 28

• Searching for Taxonomies on page 29

Installing Workbench
HP SOA Systinet Workbench is an Eclipse development platform distributed as a zip file, hp-soa-systinet-
workbench-3.00-win32.zip.

For supported platforms and known issues, see readme.txt alongside the archive.

To install HP SOA Systinet Workbench:

• Extract the archive to your required location, referred to in this document as WB_HOME.

To start HP SOA Systinet Workbench:

• Execute WB_HOME/systinet-workbench/start.exe.

The first time you start Workbench, the welcome screen opens, as shown in Figure 8.
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Figure 8. Workbench Welcome Screen

Select one of the options to open one of the editor tools, start a new editing project, or view the documentation
set.

You can return to the welcome screen from any of the editor tools by selecting Help→Welcome from the
menu options.

HP SOA Systinet Workbench requires Java SE Development Kit (JDK) 1.5.0 or higher. You must
include the path to this version of the JDK in the JAVA_HOME environment variable.

HP SOA Systinet Workbench is memory-intensive. If you experience performance issues, HP
recommends increasing the memory allocation.

To increase the memory allocation for HP SOA Systinet Workbench:

1 Open WB_HOME/start.ini for editing.

2 Set these new values:

• -Xms128m

• -Xmx1024m
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3 Save your changes.

4 Restart Workbench.

Creating a Taxonomy Project
To work with taxonomies, you need a Taxonomy Project. You can create any number of Taxonomy Projects
to help organize your work.

To create a Taxonomy Project:

1 Do one of the following:

• In the Workbench Welcome page, click Create Taxonomy Project.

• Click New  to open the Select a Wizard window, and then select SOA Systinet→Taxonomy
Project.

• Select File→New→Taxonomy Project.

• Press Alt+Shift+N, and then, press R to open the Select a Wizard window. Then select SOA
Systinet→Taxonomy Project.

The New Taxonomy dialog box opens.

2 In the New Taxonomy Project dialog box, enter the required parameters.

3 Click Next to select or create a server.

If no servers are currently defined, the dialog box continues to Step 5.

4 Do one of the following:

• Select Create a New Server, and then click Next.
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Continue to Step 5.

• Select Use an Existing Server, select the server from the list and input its credentials, and then
click Next.

Continue to Step 6.

5 In the New Server dialog box, enter the required parameters, and then click Next.

6 Select taxonomies to download from the server, as described in Updating, Importing, and Exporting
Taxonomies on page 36.

7 Click Finish.

Downloading Taxonomies from a Server
Initially, Taxonomy Editor does not contain any taxonomies. To edit SOA Systinet taxonomies, you must
download them from a server.

To download taxonomies from a server:

1 In Server Explorer, right-click the server containing the taxonomies you need to open its context menu,
and select Download taxonomy.

The Download Taxonomies wizard opens.

2 Select the taxonomies to download and click Next.

The Choose Location dialog box opens.

3 Select the project to add the taxonomies to, and then click Finish.

Taxonomy Editor displays the download progress. When the download is complete, the taxonomies are
visible in Project Explorer.
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Searching for Taxonomies
This section describes the search facilities provided by Taxonomy Editor. It includes the following sub-
sections:

• Quick Find Taxonomy on page 29

• Advanced Searching on page 30

Quick Find Taxonomy

Quick Find is the easiest way to find a taxonomy.

To use Quick Find:

1 Do one of the following:

• Click Search, and then select Quick Jump.

• Press Ctrl+J.

The Find Taxonomy dialog box opens. For details, see Find Taxonomy on page 62.

2 In the input field, enter a search string.

3 Click View Menu , and then select one of the following options:

• Show in the tree without opening detail

Shows the taxonomy in the tree but does not open its details page.

• Case-sensitive

Enables a case-sensitive or case-insensitive search.

4 In the in project field, select in which project to search for the taxonomy.

Taxonomies that match your search criteria are displayed in the Matching taxonomies pane.
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5 Select the required taxonomy and click Open taxonomy.

The taxonomy opens in the Editor pane.

Advanced Searching

For a more detailed search, you can use Taxonomy Editor Advanced Search to do the following:

• Search for a specific property type.

• Search according to a specific value of a property.

• Search different text strings: full text, regular expression, or whole word.

To use advanced search:

1 Do one of the following:

• Select Search→Search.

• Press Ctrl+H.

The Search dialog box opens.

2 Select the Taxonomy Search tab to open the dialog box. For details, see Search Taxonomy on page
63.

3 In the Containing text field, do one of the following:

• Enter the text to search.

• Select text used in a previous search by using the drop-down list.

4 In Search only in, choose the taxonomy properties or categories to search.

5 In Search controls, select one or more of the following:

• Case-sensitive

Chapter 230



To perform a case-sensitive search.

• Whole words only

To search for whole word matches.

• Regular expression

To search using regular expressions.

6 In Scope, select one of the following:

• Workspace

To search the Eclipse workspace.

• Selected resources

To search all entities selected in Project Explorer.

• Working set

To customized resources from Project Explorer.

7 Click Choose.

The Select Working Sets wizard opens.

Do one of the following:

• Select from existing working sets.

• Create new working sets.

8 Click Search.

The results are displayed in the Search view of the UI.
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3 Manipulating Taxonomies

This chapter describes how to work with taxonomies, as detailed in the following sections:

• Creating Taxonomies on page 33

• Modifying Taxonomies on page 34

• Deleting and Restoring Taxonomies on page 35

• Updating, Importing, and Exporting Taxonomies on page 36

Creating Taxonomies
In Creating a Taxonomy Project on page 27, you created a Taxonomy Project and looked at how to download
taxonomies. The following section describes how to create new taxonomies.

To create a new taxonomy:

1 Do one of the following:

• Click New  to open the Select a Wizard dialog box, and select HP SOA Systinet→Taxonomy,
and then click Next.

• Select File→New→Taxonomy.

• Press Alt+Shift+N to open the context menu, and then select Taxonomy.

The New Taxonomy wizard opens.

2 In the New Taxonomy wizard, enter the required parameters.
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A default Taxonomy ID and Filename are assigned according to the Taxonomy Name entered.
The Source Folder is assigned by default, according to whether there is an active extension
project. You can change these parameters to meet your requirements.

3 Open the Categories tab and add the categories you need. For details, see Categories Tab on page 18.

4 Open the Advanced tab and enter the required parameters, as described in Advanced Tab on page 20.

5 Click Finish to create the taxonomy.

The taxonomy is now visible in Project Explorer.

Modifying Taxonomies
A taxonomy can be modified in the following ways:

• Editing Taxonomy Properties on page 34

• Refreshing Taxonomies to Reflect External Changes on page 34

• Cutting, Copying, and Pasting Taxonomies on page 35

Editing Taxonomy Properties

To edit a taxonomy's properties:

1 Double-click the taxonomy in Project Explorer to open the Editor pane.

2 Edit properties as required in the tabs of the Editor pane. For details, see Editor Pane on page 16.

3 Click Save.

The changed status of the taxonomy is displayed in Project Explorer.

Refreshing Taxonomies to Reflect External Changes

If you want the Editor to reflect changes made outside of Taxonomy Editor, you can refresh the taxonomy.
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To refresh a taxonomy, do one of the following:

• Right-click the individual taxonomies or the project in Project Explorer to open the context menu, and
then select Refresh.

• Select the individual taxonomies or the project in Project Explorer, and then press F5.

The selected taxonomies are then updated to reflect external changes.

Cutting, Copying, and Pasting Taxonomies

You can copy or move taxonomies from one project to another using cut, copy, or paste.

To copy or move a taxonomy to a different project:

1 Right-click the taxonomy in Project Explorer and select Copy or Cut.

2 Right-click the project to which you want to copy or move the taxonomies and select Paste.

The taxonomies are then either copied or moved to the other project.

A pasted taxonomy has the status:

• New

If a taxonomy of that name is new to that location.

• Modified

If an existing taxonomy is overwritten.

Deleting and Restoring Taxonomies
You can also delete taxonomies and restore them from your local history.

To delete a local taxonomy:

1 Right-click the taxonomy in Project Explorer to open its context menu, and then select Delete.
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2 Confirm deletion of the taxonomy when prompted.

To restore a deleted taxonomy:

1 Right-click the project in Project Explorer to open its context menu and select Restore from Local
History.

The Restore from Local History dialog box opens.

2 Select the check box of the required taxonomy and click Restore.

3 Download the published taxonomy from the server, as described in Downloading Taxonomies from
a Server on page 28.

To delete a taxonomy from the server:

1 Right-click the taxonomy in Project Explorer to open its context menu and select HP SOA
Systinet→Delete Taxonomy.

2 Choose if you also want to delete the local copy.

3 Confirm deletion of the taxonomy when prompted.

Updating, Importing, and Exporting Taxonomies
You can create taxonomies, download them from an SOA Systinet server, or import them from a file. After
you download taxonomies, you can update, export, or compare them.

The following sections describe these procedures:

• Updating Taxonomies From the Server on page 37

• Importing and Exporting Taxonomy Files on page 37

• Comparing Taxonomies on page 38
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Updating Taxonomies From the Server

If the most current version of a taxonomy exists on a server, you can update your local copy to reflect any
changes.

To update a local taxonomy:

• Right-click the taxonomy in Project Explorer to open the context menu, and then select HP SOA
Systinet→Update Taxonomy.

Confirmation is required to overwrite existing taxonomies.

Importing and Exporting Taxonomy Files

You can import and export taxonomies between your projects and your local file system.

To import a taxonomy from your file system:

1 In Project Explorer, right-click the taxonomy project to which you want to import taxonomies to open
its context menu, and then select Import→Taxonomy.

The Import Taxonomies wizard opens. For details, see Import Taxonomies on page 59.

2 Browse for the folder from which you want to export taxonomies in the Folder field.

The selected folder is displayed in the left pane.

3 Click the check box of the chosen folder.

Compatible file types are displayed in the right pane.

4 Click the check box of the files you want to import and, and then browse for the required import folder
in the Into folder field.

5 Click Finish.

37Manipulating Taxonomies



6 Publish the taxonomies to an SOA Systinet repository, as described in Publishing Changes on page
43.

When importing a taxonomy from a file whose file name already exists in the local folder, Taxonomy
Editor asks if you want to overwrite the taxonomy. If you click Yes or Yes To All, the current
taxonomy is updated by attributes and categories from the XML file and its status is changed to
modified.

To export a taxonomy:

1 Right-click the taxonomy in Project Explorer to open its context menu, and then select Export to open
the Export wizard. For details, see Export Wizard on page 60 and Export Wizard: Select files on page
61.

2 Select the required file type and click Next to open the corresponding wizard.

3 Browse for the required destination and enter the required parameters.

4 Select whether to overwrite existing files.

5 Click Finish

You can export a taxonomy to any file type supported by Eclipse. For example:

• XML file

• JAR archive

• EAR-deployable or JAR-deployable archive

Comparing Taxonomies

If you are importing or exporting taxonomies between servers, it is essential to compare taxonomies to keep
track of changes.

Taxonomy Editor enables you to compare the following taxonomies:
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• Local taxonomy against the server taxonomy.

• Server taxonomy against a local history taxonomy.

To compare taxonomies:

Right-click the taxonomies you want to compare in Project Explorer to open a context menu, and then select
one of the following:

• Compare With→Each Other

• HP SOA Systinet→Compare with the latest on server

• Compare With→Local History

Results are displayed in the Compare view of the UI, as shown in Figure 9.

Figure 9. Compare Taxonomies: Results

The Compare view lists differences in the categories and properties of two taxonomies. Click a difference
to display details in the Taxonomy Compare Results section.
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Each difference is prefixed by an icon, as shown in Table 3.
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Table 3. Comparing Taxonomies

ResolutionDescriptionIcon

To resolve this issue, do one of the following:The categories exist in the first
taxonomy but not in the second.

• Right-click the first taxonomy to open its context
menu, and then select Remove from.

The differing categories are removed from the
taxonomy.

• Right-click the first taxonomy to open its context
menu, and then select Copy from.

The differing categories are copied from the first
taxonomy to the second taxonomy.

To resolve this issue, do the following:The properties in the two taxonomies
or categories are different.

• Right-click the first taxonomy to open its context
menu, and then select Copy from. Select whether you
want copy from the first taxonomy to the second, or
from the second to the first.

The properties of the taxonomy that you copied to are
overwritten by those of the taxonomy you copied
from.
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ResolutionDescriptionIcon

To resolve this issue, do one of the following:

• Right-click the second taxonomy to open its context
menu, and then select Remove from.

The differing categories are removed from the
taxonomy.

• Right-click the second taxonomy to open its context
menu, and then select Copy from.

The differing categories are copied from the second
taxonomy to the first taxonomy.

The categories exist in the second
taxonomy but not in the first.
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4 Publishing Taxonomies

This chapter describes how to publish taxonomies, as detailed in the following sections:

• Publishing Changes on page 43

• Example: Creating and Publishing a Department Taxonomy on page 44

Publishing Changes
Publishing is the process of storing changes on an SOA Systinet server.

To publish a taxonomy:

• Right-click the taxonomy in Project Explore to open its context menu, and then select HP SOA
Systinet→Publish Taxonomy.

The taxonomy is published to the defined SOA Systinet server.

You cannot publish a System taxonomy to a remote repository.

The status of a taxonomy is explained in Table 4.
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Table 4. Taxonomy Status After Publication

ImpactDescriptionStatus

Publication was successful, including
any modifications.

Local and server versions are
identical.

UP-TO-DATE

Publication was unsuccessful and the
status is unchanged. Possibly due to
one of the following:

Local version of the taxonomy has
not been published to the server.

NEW ?

Changes have been made to a local
version of a taxonomy after it has
been published.

MODIFIED >

• Exception error.

• Breach of server data integrity.

Changes to these taxonomies cannot
be published.

Taxonomies automatically generated
by the SOA Systinet Platform. For
system use only.

SYSTEM 

Example: Creating and Publishing a Department Taxonomy
In this example, you create and deploy a new taxonomy containing the identities of departments in your
organization.

Before proceeding, you must do the following:

• Define your SOA Systinet server.

• Update the local taxonomies, as described in Updating Taxonomies From the Server on page 37.

To create a department taxonomy:

1 Create a new taxonomy, entering Departments as the Taxonomy Name.

For details of the procedure, see Creating Taxonomies on page 33.

2 Open the Departments Editor and select the Categories tab.

3 Add the following categories:
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HR•

• IT

• Payroll

• Finance

• Sales

• Development

• QA

For details of the procedure, see Add a New Category on page 18.

4 Press Ctrl+S to save the taxonomy.

The Departments taxonomy is now visible in Project Explorer.

5 Right-click the Departments taxonomy to open its context menu, and then select one of the following:

• HP SOA Systinet→Publish Taxonomy

To publish the taxonomy to the defined SOA Systinet server.

• HP SOA Systinet→Publish To Other Server

To publish the taxonomy to a different server. For details, see Creating a Taxonomy Project on
page 27.

To view the published taxonomies in the repository:

1 Open the Tools tab to view the Catalog Browser.

2 Expand Categories, and then click Taxonomies.
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5 Deploying Taxonomies

This chapter explains how to deploy a set of taxonomies as an Extension Project.

This process consists of the following steps:

• Building a Taxonomy Extension on page 47

• Applying Extensions on page 47

• Redeploying the EAR File on page 51

Building a Taxonomy Extension
After publishing taxonomies, you can copy them to a Taxonomy Extension.

To build a Taxonomy Extension:

1 Right-click the taxonomy project in Project Explorer to open its context menu, and expand HP SOA
Systinet→Build Extension to open the location browser.

2 Enter a name for the extension project and browse for the location you want to save the project to, and
click Save.

All taxonomies from the selected taxonomy project are copied to the Taxonomy Extension.

Applying Extensions
You can extend SOA Systinet by adding libraries or JSPs to the deployed EAR files, by modifying the data
model, by configuring the appearance of the UI, and by importing pre-packaged data.

Extensions to SOA Systinet come from the following sources:

• Customization Editor
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Typical extensions created by Customization Editor contain modifications to the data model and artifact
appearance and possibly data required by the customization (taxonomies). They may also contain new
web components which may include custom JSP and Java code.

• Assertion Editor, Report Editor, and Taxonomy Editor

These extensions contain assertion, reporting, and taxonomy data only and do not involve changes to
the data model.

The setup tool opens the EAR files, applies the extensions, and then repacks the EAR files.

Apply extensions according to one of the following scenarios:

• Single-Step Scenario on page 48

The setup tool performs all the processes involved in applying extensions, including any database
alterations, as a single step.

• Decoupled DB Scenario on page 50

Database SQL scripts are run manually, and the setup tool performs the other processes as individual
steps that are executable on demand. This is useful in organizations where the user applying extensions
does not have the right to alter the database, which is done by a database administrator.

Single-Step Scenario

Follow this scenario if you have permission to alter the database used for SOA Systinet.

To apply extensions to SOA Systinet in a single step:

1 Make sure that all extensions are in the following directory:

SOA_HOME/extensions

The setup tool automatically applies all extensions in that directory.

If you are applying extensions to another server, substitute the relevant home directory for
SOA_HOME.
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2 Stop the server.

3 Start the setup tool by executing the following command:

SOA_HOME/bin/setup.bat(sh)

4 Select the Apply Extensions scenario, and click Next.

The setup tool automatically validates the step by connecting to the server, copying the extensions,
and merging the SDM configuration.

If you extension does not contain data model changes, select Apply Extensions Don't Touch
DB.

5 Click Next for each of the validation steps and the setup execution.

This process takes some time.

6 Click Finish to end the process.

7 Deploy the EAR file:

• JBoss

The setup tool deploys the EAR file automatically.

If you need to deploy the EAR file to JBoss manually, see Redeploying the EAR File on page 51.

• For other application servers, deploy the EAR file manually.

For application server specific details, see "Deploying the EAR File" in the HP SOA Systinet
Installation and Deployment Guide .
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8 Restart the server.

The setup tool normally applies ALTER scripts if database changes are required for an extension.
If the ALTER script cannot be used, then a DROP/CREATE process may be used instead. In these
cases, you must recreate indices on the database.

SOA_HOME/log/setup.log contains the following line in these cases:

Could not apply alteration scripts, application will continue with slower DB drop/create/restore

scenario. ... .

Decoupled DB Scenario

Follow this scenario if the user who applies extensions does not have permission to modify the database.

To apply extensions and modify the database separately:

1 Make sure that all extensions are in the following directory:

SOA_HOME/extensions

The setup tool automatically applies all extensions in that directory.

2 Stop the server.

3 Start the setup tool by executing the following command:

SOA_HOME/bin/setup -a.

4 Select the Apply Extensions scenario, and click Next.

5 Click Next, to execute the extension application, and exit the setup tool.

6 Provide the scripts from SOA_HOME/sql to the Database Administrator.

The database administrator can use all.sql to execute the scripts that drop and recreate the database
schema.
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7 Execute the setup tool in command line mode to finish the extension application:

SOA_HOME/bin/setup -c

8 Redeploy the EAR file:

• JBoss

The setup tool deploys the EAR file automatically.

If you need to deploy the EAR file to JBoss manually, see Redeploying the EAR File on page 51.

• For other application servers, deploy the EAR file manually.

For application server specific details, see "Deploying the EAR File" in the HP SOA Systinet
Installation and Deployment Guide .

Redeploying the EAR File
After using the setup tool to apply extensions or updates, you must redeploy the EAR file to the application
server. For JBoss, you can do this using the setup tool.

For other application servers, follow the EAR deployment procedures described in the "Deploying
the EAR File" in the HP SOA Systinet Installation and Deployment Guide .

To redeploy the EAR to JBoss:

1 Stop the application server.

2 Start the setup tool by executing the following command:

SOA_HOME/bin/setup.bat(sh).

3 Select the Advanced scenario, and click Next.

4 Scroll down, select Deployment, and then click Next.
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5 When the setup tool validates the existence of the JBoss Deployment folder, click Next.

6 Click Finish to close the setup tool.

7 Restart the application server.
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6 Conflicts and Validation Issues

Resolving Conflicts and Validation Issues
Editing taxonomies can result in validation and conflict issues, as described in the following sections:

• Local Validity on page 53

• Conflict With Server on page 53

• Repair Action on page 54

Local Validity

By default, the validity of local taxonomies is constantly checked as you modify them.. Invalid taxonomies
are marked in Project Explorer and the associated errors are listed in the Problems view. For example, errors
for two taxonomies with the same ID can be seen in Figure 10.

Figure 10. Invalid Local Taxonomies

To disable validation, from the menu, deselect Build automatically.

Conflict With Server

A local taxonomy and the version on a server can come into conflict either when the version on the server
is changed or when changes to the local version affect artifacts on the server.
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Conflicts are displayed when you try to publish the taxonomy. An error message is displayed, stating that
the taxonomy could not be published.

To help prevent conflicts, you can do the following:

• Right-click the taxonomy in Project Explorer to open its context menu, and then select one of the
following:

• HP SOA Systinet→Show Artifacts Using Taxonomy

All artifacts categorized by the taxonomy are displayed in the View pane of the UI.

• Right-click the taxonomy in Project Explorer to open its context menu, and then select HP SOA
Systinet→Validate Data Consistency

Conflicts are displayed in the Problems pane of the UI, as shown in Figure 11.

Figure 11. Validation Results

There are several reasons for a publication attempt not being completely successful. Troubleshooting tips
for the most common reasons are provided in Issues and Resolutions on page 65.

Repair Action

The Data Consistency Check reports artifacts that use categories which no longer exist in the taxonomy
project.

Taxonomy Editor features a Repair Action which enables you to resolve these inconsistencies.
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To repair an inconsistency:

1 In the Validation Results view, right-click the inconsistent category to open its context menu, then
select one of the following:

• Remove Referenced Category From Artifact

• Change Category

2 Re-run validation.

55Conflicts and Validation Issues



Chapter 656



A Keyboard Shortcuts

ContextActionShortcut

GlobalAdd SOA Systinet serverCtrl+Alt+S

GlobalNew taxonomyCtrl+N

 

Categories tabAdd next categoryAlt+A, Insert

Categories tabAdd child categoryAlt+C

Categories tabMove category upAlt+U, Ctrl+ArrowUp

Categories tabMove category downAlt+D, Ctrl+ArrowDown

Categories tabMove category left (unindent)Alt+E, Ctrl+ArrowLeft

Categories tabMove category right (indent)Alt+I, Ctrl+ArrowRight

Categories tabNavigate to Category Name fieldF2

Categories tabForget changes in current text field and
navigate to Category Structure

Esc

Taxonomy EditorSwitch to Next Editor tabCtrl+PgDn

Taxonomy EditorSwitch to Previous Editor tabCtrl+PgUp

 

GlobalActivate editorF12

GlobalClose current editorCtrl+W, Ctrl+F4

GlobalClose all editorsCtrl+Shift+W,
Ctrl+Shift+F4

GlobalGo to next editorCtrl+F6

GlobalGo to previous editorCtrl+Shift+F6

GlobalSwitch to editorCtrl+Shift+E
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ContextActionShortcut

 

GlobalQuick find taxonomyCtrl+J

GlobalSearch taxonomy or categoryCtrl+H

 

GlobalShow editing resource in Taxonomy ExplorerAlt+Shift+W

GlobalRefresh itemsF5

 

GlobalSave changes for active editorCtrl+S

GlobalSave changes for all editorsCtrl+Shift+S

 

GlobalCopyCtrl+C, Ctrl+Insert

GlobalCutCtrl+X, Shift+Delete

GlobalDeleteDelete

GlobalPasteCtrl+V, Shift+Insert

 

GlobalShow key assistCtrl+Shift+L
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B Dialog Boxes

Import Taxonomies
Select taxonomy files to import into your taxonomy project:

DefinitionParameter

Browse for the source folder containing the taxonomy files you want to import.Folder

Select the source folder containing the taxonomy files you want to import.Left Pane

Select the individual taxonomy files you want to import.Right Pane
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DefinitionParameter

Browse for the destination folder into which you want to import the selected
taxonomies.

Into Folder

Export Wizard
Select a destination for the taxonomies you wish to export:
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DefinitionParameter

Enter text to filter your search.Select an export
destination

Select File System as your destination folder.Tree View

Export Wizard: Select files

Select the taxonomies you want to export, then browse for the destination directory:
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DefinitionParameter

Select the project from which you want to export taxonomies.Left Pane

Select the individual taxonomies you want to export.Right Pane

Browse for and select the directory into which you want to export the selected
taxonomies.

To Directory

Find Taxonomy
A quick search for matching taxonomies:

DefinitionParameter

Enter text to filter your search results.Top Field

A list of taxonomies matching your search request.Matching
Taxonomies

Select the project in which you want to search for taxonomies.In Project
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Search Taxonomy

An advanced search for matching taxonomies:

DefinitionParameter

Enter text to search or use the drop-down menu to select a previous search parameter.Containing Text

Browse for and select a working set as a scope for your search.Working Set
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C Troubleshooting

Issues and Resolutions

SeverityTypeResolutionIndicationsCase

ErrorConflictTo replace the local
taxonomy with the server
version, use the taxonomy
context action SOA
Systinet→Update
Taxonomy. You might
want to first copy your
local version to a
temporary location.

Your local taxonomy is
CONFLICTING. The
local version cannot be
published and its
modifications are kept.

A taxonomy was changed
on the remote server
while you were modifying
your local version.

ErrorConflictTo replace the local
taxonomy with the remote
server version, use the
taxonomy context action
SOA Systinet→Update
Taxonomy. You might
want to first make a
backup copy your local
version.

Taxonomy is
CONFLICTING. The
local version cannot be
published. Changes to the
local taxonomy and server
remain in Project
Explorer.

A taxonomy was
published that has the
same file name as a new
taxonomy you are trying
to publish to the remote
server.

ErrorValidation
Results

Change the ID of the new
taxonomy.

The local taxonomy
cannot be published.
Changes to the local
taxonomy and server
remain in Project
Explorer. The Validation
Results include a node
giving the taxonomy ID.

The taxonomy you have
created has the same ID
as an existing taxonomy
on the remote server

65



SeverityTypeResolutionIndicationsCase

ErrorValidation
Results

To restore the original
taxonomy, use the
taxonomy context action
SOA Systinet→Update
Taxonomy.

The local taxonomy
cannot be published and
remains MODIFIED. The
Validation Results list
artifacts that use the
taxonomy.

You have changed the ID
of a taxonomy used by
artifacts.

ErrorValidation
Results

To restore the original
taxonomy, use the
taxonomy context action
SOA Systinet→Update
Taxonomy.

The local taxonomy
cannot be published and
remains MODIFIED.
Validation Results lists
artifacts that use the
category.

A category that you
modified is used by other
artifacts.

ErrorLocal
Inconsistency

Change taxonomy ID to
another value.

An error message for this
taxonomy is shown.

A new taxonomy ID is
identical to that of another
local taxonomy.

WarningLocal
Inconsistency

Change taxonomy ID to
valid format.

A warning message for
this taxonomy is shown.

Taxonomy ID format is
invalid.

ErrorLocal
Inconsistency

Change the category
value.

An error message for this
taxonomy is shown.

Category value is
duplicated by another
category in the same
taxonomy.

ErrorLocal
Inconsistency

Change file name so that
it does not contain invalid
character.

An error message for this
taxonomy is shown.

Taxonomy file name
contains invalid character
for REST URL.
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